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About this Handbook 
 
This first edition of the Training and Reference Manual has been created to help you understand your 
product and what support options are available. This first edition of this training guide includes changes 
and additions made through May 2012. 
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Introduction 
 

1.1 WELCOME NOTE 
The fact of the matter is there are huge amounts of money to be made in offline. One of 

those hot niches is social media. The market is hot with a ton of room to grow. Almost 

every business has a website but many businesses have not yet adopted social media 

strategies in order to gain more customers and utilize these channels for other useful 

purposes. This is where you can make the big bucks. These are the businesses that you 

need to focus on because these are the businesses that if they implement these strategies, 

they will see an increase in revenue generation. Much easier said than done, but the 

formula is easy. 

 

1. Approach the business 

2. Present your offer via a PowerPoint 

3. Sell services 

4. Implement services and collect your money 

5. Continue to manage their campaign over the long run to collect recurring fees 

 

 

Read this quick guide, customize your own PowerPoint presentation by putting the Social 

Media slides in it and hit the streets, in person, not via e-mail so that you can start closing 

businesses with your services. Personal contact will take much more courage but the 

closing rates are over ten times as high as e-mail. 

 

So read on! 

1.2 INTRODUCTION 
We highly recommend you use PowerPoint 2007 or 2010 to edit these PowerPoint. While 

we have tested the presentations in PowerPoint 2003 and Open Office, both software 

packages lack some features (such as transitions). Additionally, there may be some slight 

formatting differences when viewing the presentation in PowerPoint 2003 and 

OpenOffice.  
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Here’s a link to a free trial of PowerPoint 2010, direct from Microsoft: 

 

http://office.microsoft.com/en-us/try/ 

 

Trial is good for 60 days and will not replace the old version of PowerPoint you currently 

have installed.  

 

If you do not even want to install PowerPoint, then you can do it all from the web and for 

free! Sign up for Microsoft Office Web Apps and you’ll be able to edit the PowerPoint 

online.  

http://office.microsoft.com/en-us/web-apps/  

 

1.3 HOW WE USE THESE WITH CLIENTS 
There are many ways we use our Offline PowerPoints with businesses. 

 

1.3.1 Online 

 

The least effective way and the lazy method. We do not recommend this but many of you 

will probably do this. You will start finding e-mail addresses online and try to e-mail 

local businesses. NOTE: BUSINESSES SUCH AS PIZZA SHOPS NEVER USE E-

MAIL EVEN IF THEY HAVE ONE ONLINE. Your closing rates will be poor but you 

can PDF these PowerPoints and approach potential clients this way. 

 

1.3.2 Walk-In 

 

This is the most effective method.  

 

Choose a time that is not busy. Mondays and Tuesdays work the best. Do not choose 

Friday because no one is in business mode. Choose an off-time for restaurants when they 

are not busy and when people are not on lunch break.  

 

Then go in, looking sharp (but not too sharp as you do not want to look like a sales guy), 

ask to speak with the manager, then ask the manager if the owner is there. Tell the owner 

that you have an idea that you would like to sit down for to discuss for 15 minutes that 

you think would greatly improve his marketing and would add a tremendous value to his 

business. 

 

http://office.microsoft.com/en-us/try/
http://office.microsoft.com/en-us/web-apps/
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If they are hesitant then start being personal and say, “Hey, I know that you may be 

hesitant about this but let me ask you this, if this idea were to bring in 100 more 

customers a month, how much would that be worth to you?” Ask them just for five 

minutes if they do not have 15. If they do not have time at all then schedule a time and if 

all else fails then just leave a presentation with them and ask for referrals. If you are a 

nice guy and they like you then they will at least give you referrals. Ask for personal 

information about these referrals so that when you contact them you don’t go in cold. 

 

Make sure your presentation is spiral bound and looks professional. Practice your 

presentation before hand. We have coaching sessions so that you sound very convincing 

and can close the deal but that is an entire other topic. Deliver with confidence and make 

sure to ask for the close at the end and ask when you can start. Try to get an immediate 

decision. If they do not decide then, the probability that they will say yes later decreases 

tremendously. 

 

1.3.3 Cold Calling 

This method is not as effective as walking in but is also a very effective. You can line up 

many calls and some argue that this is the most effective method per time spent since it 

takes much more time to do walk-ins. The key is that you want to speak with the decision 

makers and set up appointments. So when you call, make sure that you sound sincere and 

get to talk to the decision maker. Do not be overly polite. Do your research about the 

decision maker and when you call say, “Hi this is Tom, is Bob there?” If they ask who 

you are then say your name. Act like you already know them so that you can get put 

through to the decision maker. If you pitch your whole idea to the secretary you will 

never sell anything and you will never get through to the actual person who makes 

decisions because you will be labeled as the sales guy. 

 

During your call, make sure to schedule a meeting. If they are busy, say 15 minutes will 

suffice. Worst case you can send them the customized PowerPoint by email but this 

decreases closing rates. The best is an in-person meeting scheduled right then and there.  

1.3.4 Friends and Family 

 

This is quite an effective method. You may want to start with friends and family at a 

discount as this will help allow you to gain experience and build a portfolio of prior 

projects. You can then use these for reviews and as referrals to potential clients. 

 

 

The most important thing is to start somewhere. MAKE ONE SALE. This will propel 

you forward. The first sale can be underpriced to get you started but then raise your 

prices around the ballpark prices we have in the PowerPoint. Just remember, you will 

never be fully prepared so go out there and make your first sale and start providing the 

value adding services that you can provide! 
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1.3.5 Presentation 

This is very important, be very informal with your clients. Do not go in and get right to 

business. Ask them about sports, their family, travel, and other things that make you 

likeable. This is very important because you gain their trust and then you can close them 

much better later. Do not call them Sir or by their last name. Go in and use their first 

name. Do not wear a suit. Look nice but no suit and no tie. You are your own business 

owner so act like that. Act like you are professional but you are a good guy and not just a 

slimy sales guy. 

1.3.6 Next 

Next up will be the technical discussion about how you can customize your PowerPoints 

for your specific customers! We recommend you tailor each PowerPoint to that specific 

customer. It can only be one slide but put that company’s logo within the PowerPoint and 

show that you did some research. It will only take a couple of seconds to brand it to the 

particular company you are pitching to. This will really make interested.  

 

1.3.7 Homework 

But before you go on you have a homework assignment! Look up five businesses (in high 

profit niches such as lawyers, nightclubs, etc) that you could offer social media services 

to and pick up the phone. Call them all and get through to the decision maker. If they are 

not there, ask when they will be there and call back then. But call five businesses. You 

don’t have to have everything prepared to make these phone calls. Just start taking action 

and then you will have the motivation and the momentum. Customizing the presentation 

is easy but take that action NOW! 

 

1.3.8 Bonus Upsell 

As you may know, we originally started in mobile marketing. Mobile marketing is a great 

upsell (or social media can be a great upsell to your mobile marketing services). The key 

is once you close the business on one thing and do a quality job, they will trust you. It is 

then easy to expand and sell them on additional services/products such as mobile 

marketing. Consider adding in a free landing page if they purchase one of your social 

media packages. We will be releasing a product Sunday, May 20
th

 that fuses mobile 

marketing with social media! These templates will allow you to easily create landing 

pages in minutes that incorporate Facebook, Twitter and YouTube on them and these are 

guaranteed to blow clients away! So keep your eyes open when we put these out! 
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2 Technical Notes Before Getting 
Started 

 

For best results be sure to install the two free fonts included in the fonts folder.  

1. League Gothic 

2. Museo 500-Regular 

Instructions for installing fonts vary by system. Please see instructions that came with 

your particular system or simply search YouTube for tutorials on installing fonts.  After 

installing the fonts please restart your computer.  

 
3 Powerpoint 2010 

3.1 HOW TO INSERT YOUR LOGO AND 

WEBSITE ON EVERY SLIDE 
You can easily change every single slide in only a few clicks! 

 

1. Navigate to each slide where you see a gray logo placeholder labeled “Logo 

here”. Delete the placeholder or insert your logo on top of the placeholder.  

 
2. Open the Slide Master 

From the menu ribbon, select the View tab > Slide Master.
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3. By default PowerPoint may drop you off on a sub-master. Be sure to scroll all the 

way to the top and select the main slide master which is marked with a #1 besides 

it. 

 
 

 

4. Now that you are on the correct slide master, simply delete the placeholder text 

and replace it with your business contact information.  You should also change 

the URL here to reflect your website address. You may also add your phone 

number here instead. You can copy and paste your logo into PowerPoint, drag and 

drop your logo into PowerPoint, or insert your logo from various menus. 

The recommended format is: 
Www.Mywebsite.Com     |     +12 34 567 890    |     Street Address 12345, City, Country 

 
 

5. When you are done editing the slide master click “Close Master View” 

3.2 CHANGE THE ACCENT COLORS 

ACROSS ALL SLIDES 
You can easily change some colors to a color that matches your company’s logo.  
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1. From any slide click the “design” tab, then click the “colors” drop down.

 
 

 

2. In the “colors” drop down please select “Create new Theme Colors”

 
 

 

3. Select the “Text/Background – Dark 2” drop down box and choose a new color 

that matches the dominant color of your logo.   
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4. Watch as all your slides change color like magic 

Please note: Only some accent colors will change. Colors like the clouds will not 

change as clouds are normally blue  

 

 

PowerPoint 2003 
 

3.1 HOW TO INSERT YOUR LOGO AND 

WEBSITE ON EVERY SLIDE 
 

Once again, you can easily change every single slide in only a few clicks! This time in 

PowerPoint 2003. If you need further guidance for a step, please see the section on 

PowerPoint 2007 / 2010 above as some steps are very similar.  

 

1. Navigate to each slide where you see a gray logo placeholder labeled “Logo 

here”. Delete the placeholder or insert your logo on top of the placeholder.  



Social Media Presentation - Training and Reference Manual 

Unique Customer Order ID 855682AR 

PowerPoint 2003 Page 11 of 15  

©Copyright 2012             
SqueezeMobi, Ltd.     
 

 

 

 
 

2. Click View from the PowerPoint menu bar at the top. From the View menu, select 

Master > Slide Master: 

 
3. By default PowerPoint may drop you off on a sub-master. Be sure to scroll all the 

way to the top and select the main slide master which is marked with a #1 besides 

it.  

4. Now that you are on the correct slide master, simply delete the placeholder text 

and replace it with your information.  You should also change the URL here to 

reflect your website address. You may also add your phone number here instead.  

The recommended format is: 
Www.Mywebsite.Com     |     +12 34 567 890    |     Street Address 12345, City, Country 
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5. Click the Close button, and you'll be returned to the main PowerPoint window. (If 

you can't see the Close button, click View from the menu bar. Then select 

Toolbars > Master.) 

 

 
 

3.2 CHANGE THE ACCENT COLORS 

ACROSS ALL SLIDES (NOT 

NECESSARY) 
You can easily change the colors from to a color that matches your company’s logo.  

1. From any slide click the “design” tab, then click the “colors” drop down. 

2. In the “colors” drop down please select “Create new Theme Colors” 

3. Select the “Text/Background – Dark 2” drop down box and choose a new color 

that matches the dominant color of your logo.   

4. Watch as all your slides change color like magic 

Please note: Only some accent colors will change. Colors like the clouds will not 

change as clouds are normally blue  

 

 

 

 

Open Office 

3.3 HOW TO INSERT YOUR INFO AND 

WEBSITE ON EVERY SLIDE 
1. Navigate to each slide where you see a gray logo placeholder labeled “Logo 

here”. Delete the placeholder or insert your logo on top of the placeholder.  
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2. From the File menu select the “Edit” dropdown, then click “Find & Replace”. 

 
 

3. Search For: SELECTING & IMPLEMENTING SOCIAL MEDIA STRATEGIES 

Replace with (please use your info, and we recommend this format for best 

results): Www.Mywebsite.Com     |     +12 34 567 890    |     Street Address 

12345, City, Country 
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4. Click the “Replace All” button 

5. Allow up to 1 minute for all the replacements to process. Once done, click the 

“Close” button.  

In some instances you may have to save (as a different filename) and reopen the 

file to see the results.  

 

 

 

4 Extras 
 

4.1 SAVE TO PDF 
We encourage you to make direct sales and show your customers only the printed hard 

copy; however, if distributing a soft copy electronic version, we recommend you 

distribute these to your clients as a PDF. A PDF copy will ensure there are no issues – 

such as the potential client not having PowerPoint, or any potential formatting issues. We 

do not recommend sending any client a PowerPoint version of the presentation as then 

they would have your original source and could duplicate your business.  

We recommend using Adobe Acrobat Professional, but it is very expensive. 

http://www.adobe.com 

 

As an alternate and a hot tip, use the free CutePDF is a great alternative. You will be able 

to print directly to PDF just like if you were printing to a real life printer. 

www.cutepdf.com 

 

http://www.adobe.com/
http://www.cutepdf.com/
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If you have PowerPoint 2010 then it allows you to Save As> PDF so you do not have to 

use CutePDF or purchase Adobe Acrobat Professional.  

 

4.2 FURTHER RECOMMENDATIONS 
The best thing you can do right now is go to the PowerPoint and customize your 

presentation. But do it quickly. THE MOST IMPORTANT THING: GET IN YOUR 

CAR AND DRIVE TO A LOCAL BUSINESS. Just do it. Start trying to sell and start 

getting those clients locked down! 

 


